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Preface 
 

Read This First 
 
About This Manual 

This manual describes the integrated bootloader application, IBoot System 
Software, initially developed for and used on the Innovator™ Development Kit. 
This manual also describes how to load and use the IBoot Core and IBoot Host 
program. 

 
Chapter 1 Introduction 

Provides an overview of IBoot System Software for the Innovator™ Development 
Kit. 

 
Chapter 2 Tools Setup 

This chapter describes how to load and set up the software tools needed to load 
and use IBoot Core, IBoot Applets and IBoot Host. 

 
Chapter 3 Loading IBoot Core 

This chapter shows how to load IBoot Core software using Code Composer 
Studio. 

 
Chapter 4 Using IBoot Host 

This chapter describes how to load operating system image files and applets into 
memory using IBoot Host. It also explains how to update the IBoot Core 
software. 

 
Chapter 5 IBoot Internal Test Software 

Provides instructions on how to use IBoot System Software, the embedded 
diagnostic package shipped with each Innovator™ Development Kit. 
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Please read each caution and warning carefully. 
 
FCC Warning 
This equipment is intended for use in a laboratory test environment only. It generates, uses, and 
can radiate radio frequency energy and has not been tested for compliance with the limits of 
computing devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide 
reasonable protection against radio frequency interference. Operation of this equipment in other 
environments may cause interference with radio communications, in which case the user at their 
own expense will be required to take whatever measures may be required to correct this 
interference. 
 
Trademarks 
Innovator™ Development Kit is a trademark of Texas Instruments. 
 
IBoot is a pending trademark of Productivity Systems, Inc. 
 
OMAP™ is a trademark of Texas Instruments. 
 
Microsoft, Windows, Windows CE, Windows CE Platform Builder, and Windows NT are 
trademarks of Microsoft Corporation. 
 
Other trademarks are the property of their respective owners. 

 
 
Change History 
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Chapter 1 – Introduction 
 
1.0 Introduction 
This manual describes the integrated bootloader application, IBoot System Software, initially developed 
for and used on the Innovator™ Development Kit. It also describes how to load and use the IBoot 
programs. 
 
The IBoot System Software is partitioned into two sub-systems the IBoot Core, which runs on an ARM 
MCP, and IBoot Host, which is a user application that runs on a PC. IBoot Core is resident in the 
Innovator™ Development Kit at all times, and is accessed by setting a dipswitch on the Processor Module 
and cycling the Innovator Module power switch or pressing the reset button on the Processor Module. 
 
IBoot Host and IBoot Core support various connection types such as USB, Ethernet and Serial. The USB 
connection is the only connection type currently supported by this version of the IBoot Core and IBoot 
Host. 
 
1.1 IBoot Overview 
IBoot Core is a boot loader and event driven core that is feature expandable via Applets. Applets are 
dynamically loadable modules (DLM) that execute on the IBoot Core and may have a graphical user 
interface. Applets may be used to test chip features or peripheral devices or may serve as demonstration 
software. 
 
1.1.1 IBoot Features 
IBoot Core is a resident application that executes on an ARM MCP and: 

• Is capable of running as a standalone application. 

• Is updateable. 

• Provides the user a means to test the peripherals and features of the product. 

• Provides the user a means to diagnose problems. 

• Utilizes a command interface and data link protocol. 

 
1.2 IBoot Host Overview 
IBoot Host provides a Graphical User Interface, running on a host machine that allows the user to load 
OS Images, IBoot Core files and IBoot Applets via the USB to an Innovator™ Development Kit device. 
 
1.2.1 IBoot Host Features 
IBoot Host a is user application that runs on a PC and provides connectivity to IBoot Core and: 

• Employs Microsoft GUI standards. 

• Allows the user to specify the connection type to the target device. 

• Allows the user to select and download an OS image to the target device. 

• Provides a user-friendly means for loading Applets. 

• Provides an efficient mechanism for updating IBoot Core and Applets. 

• Utilizes a command interface and data link protocol. 

• Supports USB, RS232 Serial, JTAG and Ethernet connection types. (USB connection is the only 
connection type currently supported). 
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1.3 Host PC Requirements 
Productivity Systems, Inc. recommends using a host PC with the following specifications: 

• 400MHz or higher Pentium II processor or equivalent 

• 30MB of free hard disk space 

• 128MB of RAM 

• SVGA (800 x 600) display minimum (1024x768 recommended) 

• Local CD-ROM drive 

 
Productivity Systems, Inc. supports the IBoot Host software on the following operating systems: 

• Windows 2000 Pro: with all updates and Service Package 2 http://windowsupdate.microsoft.com/  

• Windows XP Pro: with all updates 

• Windows NT 4.0 

 
 
NOTE: To install the IBoot System Software, you may need Administrator rights on your 
computer. See your Systems Administrator for assistance. 
 
 

WARNING! - Installing the IBoot Host software on other operating systems is at the 
users own risk and may cause unpredictable behavior. Windows 95, 98, and XP are 
not supported at this time. 
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Chapter 2 – Tools Setup 
 
2.0 Tools Setup 
This chapter describes how to load and set up the tools used by the IBoot System Software. These 
include: 

• IBoot Host 

• USB Driver for the Innovator Module 

• Spectrum Digital XDS510PP+ Drivers 

• Code Composer Studio 

• Code Composer Studio GEL Scripts 
 
Before starting the installation of the required software packages, the user installing the software may 
need to have administrative rights on the computer. 
 
NOTE: NT User’s must use the NT Installation procedures; the USB driver will be loaded 
automatically during IBoot Host Installation. 
 
2.1 IBoot Host Installation from the Innovator™ Development Kit CD 
Before software downloads can be performed using the IBoot System Software, IBoot Host must be 
loaded on the host PC. After IBoot Host has been loaded, it will be necessary to load an Innovator USB 
driver in order to connect the Innovator Module to the host PC. To load IBoot Host, proceed as follows: 
 
Step 1: Locate the setup.exe file on the Innovator™ Development Kit CD. The path is: 

D:\DCB_Install\Setup_1.3.6. 
 
Step 2: Double-click on the setup file. Click Next when the InstallShield Wizard Welcome screen appears. 
 

 

Figure 1.  InstallShield Wizard Welcome Screen 
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Step 3: Enter a location for the IBoot Host program, or use the default setting. Click Next. 
 

 

Figure 2.  Destination Folder Screen 

Step 4: Select the Setup Type. Typical is recommended in most cases. Click Next. 
 

 
Figure 3.  Installation Type Screen 
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Step 5: The setup status is displayed while the program is being loaded. Setup can be stopped at any time 
using the Cancel button. 

 

 

Figure 4.  Setup Status Screen 

 
Step 6: Click on Finish to complete the installation. You will not have to reboot your PC. 
 

 

Figure 5.  InstallShield Wizard Complete Screen 
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2.2 IBoot Host Installation from the PSI website 
To load IBoot Host from the website, proceed as follows: 
 
Step 1: Navigate to the IBoot Host page under Software. 
 
Step 2: Click on the IBootHost Loader IBoot 1.3.6 Host link. 
 
Step 3: When the File Download screen appears, click Open to unzip the setup files to your PC. 
 
 

 

Figure 6.  IBoot Host Setup Download Screen 

 
Step 4: When the WinZip Self-Extractor screen appears, enter C:\ in the Unzip to folder window. 
 

 

Figure 7.  WinZip Self-Extractor Screen 

 
Step 5: Click the Unzip button to extract the setup files. 
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Step 6: When the unzipped successfully message appears, click OK and Close on the WinZip Self-
Extractor Screen. 

 
 

 

Figure 8.  Unzipped Successfully Screen 

 
Step 7: Locate the setup.exe file in the C:\Setup_1.3.6 folder and double-click on the file to load IBoot Host. 

This will launch the InstallShield Wizard to take you through the IBoot Host installation. 
 
 
 

 

Figure 9.  IBoot Host InstallShield Wizard Initialization Screen 
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Step 8: Click Next when the InstallShield Wizard Welcome screen appears. 
 

 

Figure 10.  InstallShield Wizard Welcome Screen 

 
Step 9: Enter a location for the IBoot Host program, or use the default setting (recommended). Click Next. 
 

 

Figure 11.  Destination Folder Screen 
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Step 10: Select the Setup Type. Typical is recommended in most cases. Click Next. 
 

 
Figure 12.  Installation Type Screen 

Step 11: The setup status is displayed while the program is being loaded. Setup can be stopped at any time 
using the Cancel button. 

 

 

Figure 13.  Setup Status Screen 

713-0001-001, Version 1.1  9 



Productivity Systems, Inc. IBoot System Software User’s Guide 
 Tools Setup – IBoot Host 

 
Step 12: Click on Finish to complete the installation. You do not have to reboot your PC. 
 

 

Figure 14.  InstallShield Wizard Complete Screen 
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2.3 USB Driver Installation 
The Innovator USB driver must be installed before the Innovator Module can communicate with the host 
PC. To load the USB driver, proceed as follows: 
 
Step 1: With Windows running on the host PC, connect a USB cable from the host PC to the Innovator 

Module via the Client USB Port. 
 
 

 

Figure 15.  Client USB Port Cable Connection 

 
Step 2: Turn on the Innovator Module. 
 
Step 3: Windows will detect the hardware by acknowledging a new USB Device has been found (this might 

take a few minutes). 
 
 

 
Figure 16.  Found New Hardware Screen 
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Step 4: Once the device has been acknowledged, the Hardware Wizard will appear. 
 
 

 

Figure 17.  Found New Hardware Wizard Screen 

Step 5: On the second screen of the Hardware Wizard, select the first option “Search for a suitable driver for 
my device” and click on Next. 

 

 

Figure 18.  USB Driver Search Screen 
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Step 6: On the Locate Driver Files screen check the second option “CD-ROM drives” and press Next. 
 
 

 

Figure 19.  Specify Driver Location Screen 

 
Step 7: A dialog box will appear asking for the directory where the driver is located. Browse to the 

Innovator™ Development Kit CD and open the Driver folder. 
 
 

 

Figure 20.  Driver Folder Location Screen 
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Step 8: In the Driver folder open the InnovatorUSB.inf file. 
 
 

 

Figure 21.  Driver Folder Screen 

 
Step 9: The Wizard will notify you when it has found the corresponding driver. Once this is done, click on 

Next and the Wizard will finish the Driver installation. 
 
 

 

Figure 22.  Search Results Screen 
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Step 10: Once the driver is installed, you will be able to find the Innovator hardware on your system’s Device 
Manager under the Universal Serial Bus Controllers as Innovator. 

 
Step 11: Open Windows Control Panel and double-click on the System icon. 
 
 

 

Figure 23.  System Icon 

 
Step 12: Click the Hardware tab on the System Properties screen. 
 
 

 

Figure 24.  System Properties Screen 

 
Step 13: Click the Device Manager button to view the Device Manager screen. 
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Figure 25.  Device Manager Screen 

2.3.1 Updating the USB Driver 
This process should provide a work around when experiencing problems using the USB Wizard when the 
recommended USB driver file is not automatically selected. 
 
Step 1: On the Device Manager screen, right click the USB icon labeled “Innovator” and select Properties 

from the popup menu. 
 

 

Figure 26.  Device Manager Popup Menu 
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Step 2: Next select the Driver tab and click on the Update Driver button. 
 

 

Figure 27.  Innovator Properties 

Step 3: When the Hardware Update Wizard will appears, select the “Install from a list or specific 
location” option and click the Next button. 

 

 

Figure 28.  Hardware Update Wizard Screen 
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Step 4: On the Search and Installation Options screen, click on the “Don’t search. I will choose the driver 
to install” option and click Next. 

 

 

Figure 29.  Search and Installation Options Screen 

Step 5: A screen will appear containing a list of the drivers to install for the Innovator device. Click on the 
Have Disk button. 

 

 

Figure 30.  Device Driver Selection Screen 
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Step 6: On the Install From Disk window select Browse and go to the directory containing the Innovator 
USB driver. 

 
 

 

Figure 31.  Install From Disk Window 

 
Step 7: Once the USB driver has been found, the Wizard will begin installation. A warning will appear to 

inform you that the driver is not digitally signed, Click “Continue Anyway”. 
 
 

 

Figure 32.  Window Logo Testing Notice Screen 
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Figure 33.  Hardware Installation Screen 

 
Step 8: Once the installation is complete, click Finish. 
 

 

Figure 34.  Hardware Update Finish Screen 

713-0001-001, Version 1.1  20 



Productivity Systems, Inc. IBoot System Software User’s Guide 
 Tools Setup – IBoot Host – NT Version 

Step 9: The Innovator entry under the USB Devices should look like the image below. If any exclamation or 
question marks appear on the icon next to the Innovator label, contact PSI for technical support. 

 

 

Figure 35.  Device Manager Screen 

 
2.4 IBoot Host Installation, NT Version 
On this version of IBoot Host, the Windows NT 4.0 USB driver will be installed during the IBoot Host 
installation. 

• When running IBoot Host, you must wait 10 seconds before connecting to the device, it will take 
Windows NT 4.0 at least 10 seconds to recognize and load the correct driver for the device. 

 
Step 1: Locate the setup.exe file on the Innovator™ Development Kit CD. The path is: 

D:\DCB_Install\SetupNT40_1.3.7. 
 
Step 2: Double-click on the setup file (setup.exe). 
 

 

Figure 36.  InstallWizard Initialization Screen 
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Step 3: Click Next when the InstallShield Wizard Welcome screen appears. 
 

 

Figure 37.  InstallShield Welcome Screen 

 
Step 4: Enter a location for the IBoot Host program, or use the default setting. Click Next. 
 

 

Figure 38.  Destination Folder Screen 
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Step 5: Select the Setup Type. Typical is recommended in most cases. Click Next. 
 

 
Figure 39.  Installation Type Screen 

 
Step 6: The setup status is displayed while the program is being loaded. Setup can be stopped at any time 

using the Cancel button. 
 

 

Figure 40.  Setup Status Screen 

713-0001-001, Version 1.1  23 



Productivity Systems, Inc. IBoot System Software User’s Guide 
 Tools Setup – IBoot Host – NT Version 

 
 

 

Figure 41.  NT Driver File Installation 

Step 7: Click on Finish. 
 

 

Figure 42.  InstallShield Wizard Complete Screen 
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Step 8: When the restart computer screen appears, you must restart your computer in order for the drivers 
to be loaded properly and to complete the IBoot Host installation. 

 
 

 

Figure 43.  Restart Computer Screen 

 
Step 9: Make sure the “Yes, I want to restart my computer now” is selected and click on the Finish 

button. 
 
 
NOTE: Disconnect the USB cable from the target device before cycling power, this will allow the USB 
drivers to be restarted properly once power returns to the target device and the USB cable is 
reconnected. Failure to disconnect the USB cable when cycling power on the target device will result 
in the IBoot Host application having problems establishing communications with the device. 
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2.4.1 IBoot Host Installation, NT Version, from the Website 
When installing from the website, the setup files are zipped (using WinZip.exe) and must be unzipped to a 
location that you specify. 
 
Step 1: Navigate to the IBoot Host page under Software. 
 
Step 2: Click on the IBootHost Loader for NT 4.0 IBoot 1.3.7 Host link. 
 
Step 3: When the File Download screen appears, click Open to unzip the setup files to your PC. 
 
 

 

Figure 44.  IBoot Host NT Setup Download Screen 

 
Step 4: When the WinZip Self-Extractor screen appears, enter a location to unzip the files and click on the 

Unzip button. In this example, C:\IbootHost_NT will be used. 
 
 

 

Figure 45.  WinZip Self-Extractor Screen 
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Step 5: After the files have been unzipped, the following notification will appear. Click OK. 
 
 

 

Figure 46.  Unzipped Successfully Notification 

 
Step 6: Click the Close button to close the WinZip Self-Extractor screen. 
 
Step 7: In the folder created above, locate the setup.exe file in the C:\IBootHost_NT\Setup_1.3.7_NT40. 
 
Step 8: Go to paragraph 2.4, Step 2 to finish the rest of the installation process. 
 
 

713-0001-001, Version 1.1  27 



Productivity Systems, Inc. IBoot System Software User’s Guide 
 Tools Setup – Spectrum Digital Drivers 

2.5 Code Composer Studio (CCS) Evaluation 
If you do not already have Code Composer Studio installed, you may purchase a copy from Texas 
Instruments, request a Code Composer Studio 90-day Evaluation Tools CD, or obtain an evaluation copy 
from their website – www.ti.com 
 
If you use the Tools CD, refer to the installation guide included on the CD Insert with Code Composer 
Studio 90-day Evaluation Tools. 
 
It is recommended that CCS be installed on a PC that has Internet access. Follow the on screen 
instructions. Use the default settings for the installation. 
 
2.6 Installing Spectrum Digital XDS510PP+ Drivers 
To load the Spectrum Digital XDS510PP+ Drivers, proceed as follows: 
 
Step 1: Open the computers Internet browser and navigate to the following address: 
 
ftp://ftp.spectrumdigital.com/pub/Software-Releases/CodeComposer-5.x/omap/Release-1.52/ 
 
 
Step 2: Right click on the file named SetupCCOMAP.exe and select Save Target As or Copy To Folder. 
 
Step 3: Save the file in a location where it can be easily accessed. 
 
Step 4: After downloading the SetupCCOMAP.exe file, navigate to the folder containing the program and 

run the program by double clicking on it. The program will install the drivers required by Code 
Composer Studio and the XDS510PP+ emulator to allow the emulator to communicate with the 
ARM and DSP processor package. When the installation program asks where it should be installed 
the user should place the files in the default location. 

 
 
Please note that the following changes are needed for use of the Spectrum Digital emulator. By 
changing these settings the user may cause undesirable effects to other installed software that 
use the Parallel Port for communications. 
 
 
Step 5: When the installation is complete, reboot the computer and enter the BIOS setup for the computer. 
 
Step 6: Check that the parallel port is setup as ECP. If ECP is not available try to set the parallel port for 

SPP or SPP8. As a last resort set the parallel port to Bi-Directional. Once the port has been properly 
set, save the settings and reboot the computer. 

 
Step 7: Connect the DB25-pin cable to the parallel port of the computer. 
 
Step 8: Connect the other end of the DB25-pin cable to the parallel port connector on the XDS510PP+ 

emulator. 
 
Step 9: Connect the power supply to the Innovator. 
 

713-0001-001, Version 1.1  28 

http://www.ti.com/
ftp://ftp.spectrumdigital.com/pub/Software-Releases/CodeComposer-5.x/omap/Release-1.52/


Productivity Systems, Inc. IBoot System Software User’s Guide 
 Tools Setup – Spectrum Digital Drivers 

Step 10: Connect the JTAG connector from the emulator to the JTAG connector on the Processor Module. 
 
 
NOTE: Pin 6 has been removed from the connector on the Processor Module and is used as a key 
for the JTAG Emulator connector. 
 
 
 Processor Module’s JTAG Connector JTAG Emulator 

 

Figure 47.  JTAG Connection 

 
Step 11: Connect the emulator power supply to the emulator. 
 
Step 12: Turn on the Innovator power switch. 
 
Step 13: The hardware is now setup and the required software has been installed. 
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2.7 Configuring and Testing the XDS510PP+ 
From the installation of the Spectrum Digital software there should be an “SDConfig” icon on the desktop 
of the computer. Double click on the icon to start the SDConfig program. 
 

 
 
Step 1: In the SDConfig program select the port in the left window that has 378 next to it. This is the 

standard parallel port LPT1 for most computers. Double click on the 378. Two sub folders should 
appear. The first is Emu. The second is Data Log. 

 
Step 2: Single click on the Emu folder. Match the settings to the example to the right. 
 

 

Figure 48.  Emu Settings 

 
Step 3: Once the settings are correct, select the File option on the top menu bar and select Save.  
 
Step 4: Select the File option on the top menu bar again and select Exit. 
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Step 5: From the desktop, restart the SDConfig program by double clicking on the SDConfig icon. Just as 
was done previously, open the 378 port and verify the settings are correct. If the settings are not 
correct, repeat the steps on this page or contact PSI for assistance. If the settings are correct, 
continue to the next step. 

 
Step 6: On the icon menu, mouse over the verify connection, , icon and click it once. The following 

information should appear in the bottom window of the SDConfig tool. 
 

** Checking for a valid emulator/eZdsp 
 
  $$ You are connected to: 
  $$ EmuProductName=XDS510PP_PLUS 
  $$ EmuPortAddr=0x378 
  $$ EmuPortMode=SPP8 
  $$ ProductId=10 
  $$ ProductVersion=02 

 
Step 7: Click on the Emulator Test, , icon. The following information should appear in the bottom 

window. 
 

** Emulator Scan Test 
   -- Found JTAG IR length of 50 
   -- Found 3 JTAG device(s) in the scan chain 

 

 

Figure 49.  Emu Scan Test 
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Step 8: Finally, click on the Emulator Reset, , icon. The following information should appear in the 

bottom window. 
 

**Emulator is reset 
 
Step 9: Select File from the top menu and Exit the SDConfig program. The emulator has successfully been 

connected to the computer and the EVM. 
 
2.8 Code Composer Studio Installation 
The following steps should be followed to properly install the OMAP™ Code Composer Studio (CCS) for 
use with Innovator You must start with Innovator turned OFF. 
 
NOTE: This software is not included in the Innovator™ Development Kit. Please contact your TI 
Sales Representative about purchasing this software if you do not have it. 
 
Step 1: Uninstall any previous versions of code composer tools through Control Panel->Add/Remove 

Programs utility. 
 
Step 2: Click on Setup.exe and an Install window will appear. Choose OK. Leave check mark in Minimize 

during install box. You will now see Code Composer Studio OMAP™ Setup window. 
 
Step 3: Keep Choosing Next and Yes for all set-up screens until install is complete. This will install your 

CCS tools in to the C:\ti directory. This process may take a few minutes. If a screen pops up saying 
a DLL file update is not needed, then simply choose OK. 

 
Step 4: At the end of install, choose “No, I do not want to restart my computer.” Close WinZip and then 

restart your computer. If you restart your computer before closing WinZip you may get incomplete 
install error messages on your screen. 

 
2.9 Copying Code Composer Studio GEL Scripts 
The following steps describe how to copy GEL Scripts and configure GEL files. 
 
2.9.1 GEL Scripts 
Step 1: Access the Innovator™ Development Kit CD and copy iARM.gel and iDSP.gel GEL Scripts from: 
 

\BIN Files 

to: 

C:\ti\cc\gel. 
 
Step 2: Use the CCS Setup, as described below, to configure Startup GEL files. 
 
2.10 Configuring Code Composer Studio 
From the installation of Code Composer Studio, there should be two icons on the desktop for CCS. 
Double-click on the Setup icon to start the setup program for CCS. If you want to save existing System 
Configurations, click the Close button when prompted from the Import Configuration window and follow 
the procedures outlined below. If you want to clear your system configuration(s), click Clear button in the 
Import Configuration window, then select Yes and Close and follow the procedures outlined below. In this 
example, we will start with the System Configuration cleared. 
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Step 1: Under System Configuration, right click on any board configuration that may be installed and select 
Remove. Respond by clicking Yes to confirm the configuration is to be removed. 

 
 

 

Figure 50.  Code Composer Studio Setup 

 
Step 2: In the right window, select Install a Device Driver. 
 
Step 3: Navigate to the C:\tieval2\drivers folder. CCS Setup may already place you there. 
 
 

 

Figure 51.  Select Device Driver File 

 
Step 4: Select the sdgo5xx.drv and click on the Open button. 
 
Step 5: In the Device Drivers properties window, click on the Ok button. 
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Figure 52.  Device Driver Properties 

 
Step 6: Repeat the driver installation process until all of the sdgoxxxx.drv driver files have been installed. 
 
NOTE: As each sdgoxxxx driver is installed, they will not disappear from the drivers folder window. Each 
new driver added will appear in the Available Board/Simulator Types center window. 
 
Step 7: Once all the drivers are installed, select Save from the File menu. 
 
 

 

Figure 53.  Device Drivers Loaded 
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Step 8: Select File again and select Exit.  
 
Step 9: Upon exiting the setup program, CCS Setup will ask if the user wishes to start CCS, select No and 

exit the program. 
 
Step 10: From the desktop icon, start the CCS Setup program again. Click on the Close button when 

prompted from the Import Configuration window. 
 
Step 11: Highlight the sdgoheterogti driver in the Available Board/Simulator Types window. In the right hand 

window, scroll if needed down to where Processor(s) Supported: is displayed. The supported 
processors should match the list shown below. 

 
 

 

Figure 54.  Processors Supported 
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Step 12: Drag the sdgoheterogti driver into the System Configuration window and release. A Board 
Properties window will appear. 

 

 

Figure 55.  Board Properties Window 

 
Step 13: Click the Next> button. 
 
Step 14: Click on the I/O Port value and change it to 0x378. 
 

 

Figure 56.  I/O Port Value Window 
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Step 15: Click on the Next> button. 
 
Step 16: For the processor configuration, use the Add Single button and add a BYPASS. Accept the default 

settings by clicking on the Ok button for the Bypass. 
 
Step 17: Use the same Add Single button to add the TMS470R2x ARM processor. Before adding the 

processor, in the Processor Name window type “ARM” and press the Add Single button. 
 
Step 18: Finally, use the same Add Single button to add the TMS320C5500 DSP processor and change the 

name to DSP in the Processor Name window.  
 
 

 

Figure 57.  Processor Configuration Window 

 
Step 19: Under the Init Order panel, change the initialization order to 3, 1, 2 by clicking on the Init Order 

number and changing its value. This will initialize the ARM first, the DSP second and Bypass third. 
 
Step 20: Click on the Next> button. 
 
Step 21: Using the double dot button on the right of each CPU, select the appropriate .gel file for that CPU. 
 
Step 22: For CPU_1, which is the TMS470R2x, use iARM.gel file. 
 
Step 23: For CPU_2, which is the TMS320C5500, use iDSP.gel file. 
 
Step 24: Click on the Finish button. 
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Figure 58.  Startup GEL Files Window 

 
Step 25: Select Save from the File menu. 
 
Step 26: From the File menu again, select Exit. 
 
Step 27: When prompted to start Code Composer Studio, make sure the Innovator is powered up and the 

emulator has power connected to it. Select Yes to start Code Composer Studio. 
 
Step 28: If everything is working correctly, the following will appear: 
 
 

 

Figure 59.  Parallel Debug Manager 

If CCS reports an error, repeat procedure beginning at Step 1. If after several unsuccessful attempts the 
problem persists, please contact PSI for assistance. 
 
When Code Composer Studio is launched, the Parallel Debug Manager utility will be displayed. The 
emulator should now be configured and verified as working. Code Composer Studio has been configured 
and verified as working. You may begin using CCS by selecting Open, and choosing either the ARM or 
DSP session. Or select File and Exit.  
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Chapter 3 – Loading IBoot Core Software 
 
3.0 Loading IBoot Core Software 
This chapter describes how to load the IBoot Core software for the first time. IBoot Core software is 
preloaded on the Innovator and should not have to be loaded unless there is a problem with it or it has 
been accidentally erased. IBoot Core Software is updated using IBoot Host. Refer to Chapter 4 for 
instructions on how this is done. 
 
NOTE: The example below uses the PCI JTAG. Your particular JTAG may indicate a different port 
address. 
 
 
3.1 IBoot Core Software Locations 
The IBoot Core Software, LoadCore.out, can be obtained from the Innovator™ Development Kit Product 
Support CD or the PSI Website. 
 
3.1.1 IBoot Core Software CD Distribution 
The LoadCore.out file can be found in D:\Software\CORE folder on the Innovator™ Development Kit CD. 
The file can be loaded from the CD or copied to a folder on your hard drive. 
 
3.1.2 IBoot Core Software Website Distribution 
The LoadCore.out file must be saved to a location on your hard drive. It is recommended that you 
download the file to the same folder that was created when IBoot Host was loaded on your PC. The 
following procedure assumes that will be the case. 
 
Step 1: Navigate to the IBoot Host page under Software. 
 
Step 2: Click on the IBoot Core used with Code Composer: LoadCore.out link. 
 
Step 3: When the File Download screen appears, click Open to launch the Save As window. 
 
 
 

 

Figure 60.  File Download Screen 
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Figure 61.  File Save As Screen 

 
Step 4: When the File Save As screen appears, place the file in the same folder that was created when 

IBoot Host was loaded: C:\PSI\IBOOT_HOST (or C:\Productivity_Systems_Inc\IBOOT_HOST 
for NT users). 
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3.2 Loading IBoot to Flash Using Code Composer Studio 
 
Step 1: Set the Innovator Memory Configuration switches: 

SW1 – Off 
SW2 – Off 
SW3 – Off 
SW4 – Off 

 
Step 2: Connect JTAG to Innovator Processor Module. 
 
Step 3: Start SDConfig.exe by double-clicking on the icon. 
 
 

 
 
Step 4: Turn Innovator Module power switch on. 
 
 

 

Reset Icon

Figure 62.  Emulator Reset 
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Step 5: Reset the JTAG Emulator by clicking on the Reset Emulator, , icon shown above. 
 
Step 6: Click on the Emulator Test, , icon (see figure below) and verify bottom two lines of text read: 

   -- Found JTAG IR length of 50 
   -- Found 3 JTAG device(s) in the scan chain 

 
 
 Emulator Test 
 
 

 

Figure 63.  Emulator Test 
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Step 7: Reset JTAG again using the Emulator Reset, , icon. 
 
 

 

Figure 64.  JTAG Reset 

 
Step 8: Open Code Composer Studio using the ARM-side. 
 
 

 
 

Figure 65.  Opening Code Composer Studio 
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Step 9: Load Program file LoadCore.out. 
 
 

 

Figure 66.  Loading IBoot Core Program 

 
A progress bar will appear to show the status of the program loading. 
 
 

 

Figure 67.  Program Loading Progress 
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Step 10: After program file loads, select Run from the Debug menu (or press F5) to download the program to 
the Innovator. 

 
 

 

Figure 68.  Downloading IBoot into the Innovator 

 
Step 11: When LoadCore begins, a splash screen will appear on the Innovator. The Status LED on the 

Innovator module will blink green while the Innovator erasing Boot Flash. The LED changes to 
orange when the software is being burned into Boot Flash and then to red when the process has 
completed. 
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Chapter 4 – Using IBoot Host 
 
4.0 Using IBoot Host 
IBoot Host provides a Graphical User Interface running on a host machine that allows the user to load OS 
Images, IBoot Core files and IBoot Applets via the USB to an Innovator™ Development Kit device. For 
the remainder of this chapter, the term Innovator will be used to refer to the Innovator Development Kit. 
The USB connection is the only connection type supported by this version of the IBoot Host, therefore the 
term connection will refer to a USB connection. IBoot Host must already be installed on the host PC. If 
IBoot Host is not yet installed, refer to Chapter 2 for installation instructions. 
 
4.1 IBoot Host GUI 
The IBoot Host GUI is comprised of a Menu Bar, Toolbar, Load Category Tab Dialog and a Status 
Window. The figure below illustrates the location of the GUI features. 
 
 

 

Toolbar 
 

 

Figure 69.  IBoot Host GUI 
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4.1.1 Menu Bar 
A menu displays a list of commands that allow you to give instructions about what you want to do. The 
IBoot Host GUI menu bar is made up of File, Edit, Connection, Tools and Help menus. These menus are 
described in the following paragraphs. 
 
4.1.1.1 File Menu 
The File Menu has two options, Print Status and Close. The Print Status option will cause whatever is 
displayed in the Status Window to be printed. The Close option will close IBoot Host. 
 
 

 

Figure 70.  File Menu 

 
4.1.1.2 Edit Menu 
The Edit Menu has only a Delete option. This option will delete whatever is highlighted in the Files or 
Flash windows in the IBoot tab. 
 
 

 

Figure 71.  Edit Menu 

 
 

 

Figure 72.  Files and Flash Windows 
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4.1.1.3 Connection Menu 
The Connection Menu allows you to select the type of connection used to connect to the Innovator 
Module. The Settings option will display a Connection Settings window with a drop down window showing 
the available connection types. 
 
 

 

Figure 73.  Connection Menu 

 
 

 

Figure 74.  Connection Settings Window 

 
4.1.1.4 Tools Menu 
The Tools Menu provides access to the Erase function. The Erase option allows you to completely erase 
any Flash memory using the Erase selection window. 
 

 

Figure 75.  Tools Menu 

 

 

Figure 76.  Erase Selection Window 
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4.1.1.5 Help Menu 
The Help Menu has two options, Contents and About. The Contents option provides access to any Help 
files that may be available for IBoot Host. The About option displays the IBoot Host version information. 
 

 

Figure 77.  Help Menu 

 

 

Figure 78.  About Screen 

 
4.1.2 Toolbar 
The Tool Bar is comprised of Connect, Erase, Help and Defrag (not implemented) buttons. The Connect 
button allows the user to establish an Ethernet, Serial or USB connection to the Innovator. The Erase 
button displays the Erase utility window that allows the user to select and erase the IBoot Flash, User 
Flash 0 or User Flash 1. The Help button lunches the Help window. The Defrag Button is not 
implemented in this version of the IBoot Host. 
 
4.1.3 Load Category Tab Dialog 
The Load Category Tab Dialog contains an Operating System Tab and an IBoot Tab. Each tab provides 
the user with a series of operations that can be performed on the Innovator. 
 
4.1.3.1 Operating System Tab 
The Operating System Tab (Figure 79) allows the user to select and load OS specific files (Images) to the 
Innovator Module. IBoot Host is currently supporting the Palm, Linux, Symbian and WinCE operating 
systems. 
 
4.1.3.1.1 Operating System Tabs 
These tabs are used to select the type of Operating System that will be loaded. 
 
4.1.3.1.2 User Flash Destination 
Allows the user to select which User Flash to load the Operating System. 
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4.1.3.1.3 Start Address Option 
This option will allow the user to select a start address in User Flash at which the Operating System will 
begin loading. 
 
4.1.3.1.4 Start Address Window 
The start address is entered in this window. The address must be entered in hexadecimal format. 
 
4.1.3.1.5 Open File Button 
The Open File button opens a browse window to locate the Operating System image file. 
 
4.1.3.1.6 OS File Path Window 
The Path window displays the path for the Operating System image file. 
 
4.1.3.1.7 Load File Button 
The Load File button begins the Operating System downloading process. 
 
4.1.3.2 IBoot Tab 
The IBoot Tab (Figure 80) allows the user to update IBoot Core software, select and load the IBoot 
Applets files to the IBoot Core running on the Innovator.  
 
4.1.3.2.1 Load IBoot Core Option 
This option allows the user to update the version of IBoot already loaded on the Innovator Module. 
 
4.1.3.2.2 Browse Button 
The Browse button opens a browse window to locate the IBoot Core update. 
 
4.1.3.2.3 IBoot Core Path Window 
This window displays the path for the IBoot Core file. 
 
4.1.3.2.4 Load Core Button 
The Load Core button begins the updating process. 
 
4.1.3.2.5 Applet Files Window 
Applet files are loaded into this window prior to loading them into Flash. 
 
4.1.3.2.6 Insert File Button 
The Insert File button opens a browse window to locate the Applet files. 
 
4.1.3.2.7 Flash Destination Windows 
Applets files are moved to the desired destination windows before they are downloaded. 
 
4.1.3.2.8 Format Button 
This button opens the format selection window to select the Flash destination to be formatted to accept 
the Applet files. 
 
4.1.3.2.9 Load Files Button 
The Load Files button begins formatting the Flash destinations selected. 
 
4.1.4 Status Window 
The Status Window displays IBoot Host execution statuses, progression of operations and the status of 
connections. 
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4.2 Establishing a Connection 
Before performing any type of execution on the IBoot Host, a connection must be established between 
IBoot Host and the Innovator Module. To establish a connection, proceed as follows: 
 
Step 1: Connect a USB cable from the USB Port on the host PC to the USB Client Port on the Innovator. If 

USB driver has not been installed, refer to Chapter 5 for instructions. 
 
Step 2: Make sure Innovator Memory Configuration Switch SW1 is set to ON. 
 
Step 3: Turn Innovator Module power switch to ON. 
 
 
 

 

Figure 81.  USB Cable Connection 

 
Step 4: Check the IBoot Host Connection Settings and make sure USB is selected. 

 
 

 

Figure 82.  Connection Settings 

 
Step 5: Press the Connect button on the tool bar. 
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Step 6: Verify connection status is displayed in the Status Window and USB icon is displayed at lower right 
hand corner of the Status Window, as shown below, while the device is connected.  

 
 

 

Connection Status 

USB Icon 

 
 

Figure 83.  Successful Connection 
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If the IBoot Host fails to establish a connection with the Innovator, a message box will appear with the 
following error: “Failed to Open Communications with the device.” The Status Window will display the 
message “The Device is not connected” any time the device disconnects, fails to connect or if a 
connection has not been attempted. If the connection fails, check the Connection Settings to see that 
USB has been selected. 
 

 

Figure 84.  Failed Connection Message 

 
NOTE: The amount of time you must wait before connecting to the device may vary depending on 
the processor speed of the system you are using. 
 
If IBoot Host fails to establish a connection to the device after several tries, do the following: 

• Close the IBoot Host application. 

• Unplug the USB cable from the device and turn off the device. 

• Turn the device on and plug the USB cable into the device. 

• Launch the IBoot Host application wait for 10 seconds and connect to the device. 
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4.3 Erasing 
IBoot Flash, User Flash 0 or User Flash 1 may be erased before loading anything into Flash. However, erasing 
is not required before an OS image is loaded. To execute an Erase command, press the Erase button on the 
tool bar or select the Erase option from the Tools Menu. When the Erase utility window appears, check the 
Flash location(s) you would like to erase and press the Erase button. The Erase command will be sent to the 
device and the erasing status will be displayed on the Innovator. All three may be erased at the same time by 
putting a check in each box.  
 
NOTE: The Erase utility will erase everything in the Flash locations selected, this includes IBoot 
Core and Operating Systems. 
 
 

 

Figure 85.  Erase Utility Window 
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Figure 86.  Sending Erasing Command to the Innovator Module 
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Figure 87.  Innovator Erasing Status 
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4.4 Updating IBoot Core from the Innovator™ Development Kit CD 
IBoot Core tab is used to update the IBoot Core software currently loaded on the Innovator. If IBoot Core 
software has not yet been installed on the Innovator or has been erased, refer to Chapter 3 to load the 
software. To update IBoot Core, proceed as follows: 
 
Step 1: Select the IBoot tab to display the dialog box and check Load IBoot Core. 
 
 

 

Figure 88.  IBoot Core Screen 
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Step 2: Click on the Browse button and locate IBootCore.plf file on the Innovator CD. The file is located in 
D:\Software\CORE. 

 
 

 

Figure 89.  Select Source File Window 

 
Step 3: Click Open to display the path and filename in the Load IBoot Core window. 
 
 

 
 

 

Figure 90.  IBoot Core File Location 
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Step 4: Click on the Load Core button to begin loading. While the file is being sent to the Innovator, the 

status of the file transfer will be displayed below the Status Window. 
 
After file transfer is complete, the Status Window will display a confirmation message, as shown below. 
 
 

 
 

Figure 91.  Successful File Transfer 
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The Innovator LED will display the status of the IBootCore.plf file replacement. A blinking green Status 
LED will indicate the flash is being erased, orange indicates flash is being burned. When the Status LED 
is solid green, the update is complete. 
 
 

Burning IBoot Core

Erase Progress

Flash Burn Progress

 

Figure 92.  IBoot Core Updating Status 
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4.5 Updating IBoot Core from the PSI Website 
IBoot Core tab is used to update the IBoot Core software currently loaded on the Innovator. If IBoot Core 
software has not yet been installed on the Innovator or has been erased, refer to Chapter 3 to load the 
software. To update IBoot Core from the website, proceed as follows: 
 
Step 1: Navigate to the IBoot Host page under Software. 
 
Step 2: Click on the IBoot Core used with Code Composer: IBootCore.plf link. 
 
Step 3: When the File Download screen appears, click Open to launch the Save As window. 
 

 

Figure 93.  IBootCore.plf File Download Screen 

 

 

Figure 94.  File Save As Window 
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Step 4: When the File Save As screen appears, place the file in the same folder created when IBoot Host was 
loaded: C:\PSI\IBOOT_HOST (or C:\Productivity_Systems_Inc\IBOOT_HOST for NT users). 

 
Step 5: Select the IBoot tab to display the dialog box and check Load IBoot Core. 
 
 

 

Figure 95.  IBoot Core Screen 
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Step 6: Click on the Browse button and locate IBootCore.plf file in C:\PSI\IBOOT_HOST folder (or 
C:\Productivity_Systems_Inc\IBOOT_HOST folder for NT users). 

 
 

 

Figure 96.  Select Source File Window 

 
Step 7: Click Open to display the path and filename in the Load IBoot Core window. 
 
 

 
 

 

Figure 97.  IBoot Core File Location 
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Step 8: Click on the Load Core button to begin loading. While the file is being sent to the Innovator, the 

status of the file transfer will be displayed below the Status Window. 
 
After file transfer is complete, the Status Window will display a confirmation message, as shown below. 
 
 

 
 

Figure 98.  Successful File Transfer 
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The Innovator LED will display the status of the IBootCore.plf file replacement. A blinking green Status 
LED will indicate the flash is being erased, orange indicates flash is being burned. When the Status LED 
is solid green, the update is complete. 
 
 

Burning IBoot Core

Erase Progress

Flash Burn Progress

 

Figure 99.  IBoot Core Updating Status 
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4.6 Loading an Operating System 
It is possible to load up to two operating systems on the Innovator, provided neither operating system is 
greater than 32M. The operating system is then selected by configuring the Memory Configuration switch. 
This chapter describes how to load operating systems into User Flash locations using IBoot Host, and 
how to select the operating system to use. This procedure assumes that IBoot (Chapter 3), USB Drivers 
(Chapter 2) and IBoot Host (Chapter 2) have already been loaded. 
 
4.6.1 Loading an Operating System into User Flash 0 
To load operating system images files into User Flash 0, proceed as follows: 
 
Step 1: Turn the Innovator Module Off and set Memory Configuration switch SW1 to On. 
 
 

 

 

Figure 100.  Memory Configurati

 
Step 2: Connect a USB cable from the USB Port on the
 
 

Figure 101.  USB Ca

 
Step 3: Turn the Innovator Module On.  
 
Step 4: Press the Connection button on the tool bar to e
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Step 5: Verify connection status is displayed in the Status Window and USB icon is displayed at lower right 
hand corner of the Status Window, as shown below, while the device is connected.  

 
 

 

Figure 102.  USB Connection Established 

 
Step 6: Click on the appropriate operating system tab to bring up the dialog screen. In this example, WinCE 

will be used.  
 
 

 

Figure 103.  Operating System Tabs 
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Step 7: Make sure User Flash 0 appears in the Destination window. If not, use down arrow to make the 
selection.  

 
 

 

Figure 104.  WinCE Dialog Screen 

Step 8: Click on Open File to enter path and filename for the operating system. 
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NOTE: An Operating System may not be included with the Innovator Development Kit and must be 
purchased separately. The following example shows the steps that should be followed if the 
Operating System were copied to a BIN folder on the PC’s hard drive. 
 
 

 

Figure 105.  Open File Window 

 
Step 9: When file is located, click on Open to display path and filename in the WinCE dialog Path window. 
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Figure 106.  Operating System File Path and Filename 
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Step 10: Click on Load File. The file will be transferred from IBoot Host to the Innovator. A “Sending File” 
indication will be displayed at the bottom of the IBoot Host screen. 

 
 

 

Figure 107.  Sending File Screen 
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Step 11: When transfer is finished, the Status Window will display “The file was sent successfully” message 
as shown in the figure below. 

 
 

 

Figure 108.  User Flash 0 File Transfer Successful 
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Step 12: Observe the following screen is displayed on the Innovator (after about 10 to 15 seconds). IBoot 
Host will erase the User Flash destination first. The Status LED will blink green while erasing. 

 

Performing UF Download
Wait for erase and burn

to complete…

Erase Progress

Flash Burn Progress

 

Figure 109.  Erasing User Flash Screen 

Step 13: Observe Status LED blinks orange when IBoot Host begins loading the User Flash.  
 

Performing UF Download
Wait for erase and burn

to complete…

Erase Progress

Flash Burn Progress

 

Figure 110.  Burning Flash Screen 

 
Step 14: The Status LED will go to solid red when loading is done. Unplug the USB cable and press SW4 to 

exit. 
 

From IBootHost:
1.  Select download file and
    destination.
2.  Press LOAD FILE
----OR----
1.  Disconnect USB Cable to
    exit
2.  Press SW4 to exit

 

Figure 111.  Loading Finished Screen 

 
Step 15: Turn the Innovator Module Off.  
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Step 16: To run the operating system, configure Memory Configuration switches as follows: 

 
SW1 – Off 

4
3
2
1

SW2 – Off 
SW3 – On 
SW4 – Off 

 
 
 

Figure 112.  Memory

 
Step 17: Power on the Innovator Module and y
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Step 3: Turn the Innovator Module On.  
 
Step 4: Click on the appropriate operating system tab to bring up the dialog screen. In this example, WinCE 

will be used. Select User Flash 1 as the Destination.  
 
 

 

Figure 115.  User Flash 1 Destination 
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Step 5: Click on Open File and enter path and filename for the operating system.  
 
 
NOTE: An Operating System may not be included with the Innovator Development Kit and must be 
purchased separately. The following example shows the steps that should be followed if the 
Operating System were copied to a BIN folder on the PC’s hard drive. 
 
 

 

Figure 116.  Open File Window 
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Step 6: When the file is located, click on Open to display the path and filename in the WinCE dialog Path 
window. 

 
 

 

Figure 117.  Operating System File Path and Filename 
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Step 7: Click on Load File. The file will be transferred from IBoot Host to the Innovator. A “Sending File” 
indication will be displayed at the bottom of the IBoot Host screen. 

 
 

 

Figure 118.  Sending File Screen 
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Step 8: When transfer is finished, the Status Window will display “The file was sent successfully” message 
as shown in the figure below.  

 
 

 

Figure 119.  User Flash 0 File Transfer Successful 
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Step 9: Observe the following screen is displayed on the Innovator (after about 10 to 15 seconds). IBoot 
Host will erase the User Flash destination first. The LED will blink green while erasing.  

 

Performing UF Download
Wait for erase and burn

to complete…

Erase Progress

Flash Burn Progress

 

Figure 120.  Erasing User Flash Screen 

Step 10: Observe Status LED blinks orange when IBoot Host begins loading the User Flash.  
 

Performing UF Download
Wait for erase and burn

to complete…

Erase Progress

Flash Burn Progress

 

Figure 121.  Burning Flash Screen 

 
Step 11: The Status LED will go to solid red when loading is done. Unplug the USB cable and press SW4 to 

exit. 
 

From IBootHost:
1.  Select download file and
    destination.
2.  Press LOAD FILE
----OR----
1.  Disconnect USB Cable to
    exit
2.  Press SW4 to exit

 

Figure 122.  Loading Finished Screen 

 
Step 12: Turn the Innovator Module Off. 
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Step 13: To run the operating system, configure Memory Configuration switches as follows: 
 
 

SW1 – Off 
SW2 – Off 

4
3
2
1

SW3 – On 
SW4 – On 

 
 
 
 
 
 

Figure 123.  Memory

 
Step 14: Power on the Innovator Module and y
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4.7 Loading IBoot Applets from the Innovator™ Development Kit CD 
The following paragraphs describe the formatting and loading of IBoot Applets. The Applets themselves 
are described in their own user guides. This procedure assumes that IBoot Core software has already 
been loaded on the Innovator Module, and IBoot Host and the USB driver have been loaded on the PC. 
 
Step 1: If not already running, launch IBoot Host by double-clicking on the IBoot Host icon on the PC 

desktop. 
 

 
 
 
Step 2: Plug the USB cable into the USB Client connector on the Innovator Module. 
 
 

 

Figure 124.  USB Client Cable Connection 

 
Step 3: Turn the Innovator Module on. 
 
 

 

Figure 125.  Setting the ON/OFF Switch to ON 
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Step 4: On the IBoot Host GUI, click once on the Connect button to establish a connection between the 

Innovator Module and the PC. 
 
 
 
 

 

Connect Button

Figure 126.  IBoot Host GUI 
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Step 5: In the IBoot Host status window, the words “Connection successful” will appear when the 
connection is established. If you get a “Failed to Connect” message, check that the USB cable is 
plugged in and the Innovator Module in on. Cycle power to the Innovator Module and click the 
Connect button again. 

 

 
 
 
 

Figure 127.
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Step 6: Click on the IBoot tab to display the screen shown below. 
 
 
 
 

 

IBoot Tab 

Figure 128.  IBoot Tab 

 
Step 7: Click once on the Insert File button to begin selecting Applet Files to load. 
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Step 8: In the Select Source File window, browse to the Software folder on the Innovator CD or the hard 
drive location where Applet files are stored, highlight the Applets you want to load and click Open, 
or double-click on the filename. You can highlight all the Applets and bring them all over at the same 
time as long as they are not designated as Read-only. 

 
 

 
 
 
 
 

 

Figure 129.  Select Source File Window 
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Step 9: Selected files will appear in the Files window on the IBoot Host GUI. 
 
 
 
 
 

 

Files Window 

 

Figure 130.  Applet Files in Files Window 
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NOTE: An Applet File can be removed from the Files windows by highlighting it and hitting the 
Delete key on the keyboard or by using the Delete option in the Edit menu. 
 
 
Step 10: Before the Applets can be loaded, the destination Flash must be formatted. Put a check in the box 

next to the Flash destination that is to be formatted. 
 
 
NOTE: It is recommended that all Applets reside in Boot Flash and Operating Systems reside in 
User Flash. 
 

 

Figure 131.  Format Selection Window 

 
NOTE: With the exception of IBoot Core in Boot Flash, the contents of the selected Flash 
destination(s) will be erased. Boot Flash is always formatted by default whenever one of the User 
Flashes is selected, but IBoot Core will remain. If an Applet is loaded into a User Flash, and an 
Operating System is loaded into that same User Flash, the Applet will be erased. Likewise, if an 
Operating System is loaded into a User Flash, any Applets that were there will be erased. 
 
Step 11: Click on the Execute button to begin formatting. 
 
Step 12: An acknowledgment to the command sent to the Innovator is displayed in the IBoot Host Status 

window (see Figure 133). The Innovator Module will display the status of the formatting process 
taking place on it (Figure 132). 

 
 

Formatting

Erasing BootFlash

 

Figure 132.  Innovator Module Formatting Status 
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Figure 133.  IBoot Host Command Acknowledgment 
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Step 13: To select the first Applet File, click once to highlight it. 
 
NOTE: Applets will be displayed on the Innovator in the order they are placed in the Flash 
windows. The Applets will build from left to right and top to bottom. Applets placed in Boot Flash 
will load first followed by User Flash 0 and then User Flash 1. Applets can be placed in any order 
you choose, there is no particular order that must be followed. 
 
 

 

Figure 134.  Highlighting an Applet File 
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Step 14: Click the Applet File again and drag it to the Flash destination window. 
 
NOTE: You must release the mouse button after you highlight the Applet File or you will add 
another copy of the Applet previously selected. You cannot click and drag in one motion. 
 
Step 15: Continue highlighting and dragging until all desired Applets Files are in a Flash window. 
 
 

 

Figure 135.  Applet File in Boot Flash Window 
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NOTE: If an Applet File appears in the destination window more than once, it will be loaded more 
than once. Before clicking on the Load Files button, scroll through the list of files and make sure 
the file appears only once. If an Applet File appears more than once, highlighting it and hitting the 
Delete key on the keyboard or using the Delete option in the Edit menu will remove it. 
 
Step 16: Click on the Load Files button to begin loading Applet Files to the Innovator Module. 
 

 

Figure 136.  All Applet Files in Boot Flash Window 
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Step 17: As files are sent, an acknowledgement is displayed at the bottom of the IBoot Host GUI. 
 
 

 

Figure 137.  Sending Files to the Innovator Module 

 
Step 18: The Status LED on the Innovator Module will be solid orange while the Applet Files are loading and 

go off when the download is finished. 
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Step 19: Remove the USB cable from the Innovator Module. 
 
Step 20: Press SW4 on the Innovator Module to display the Applets. 
 
 
NOTE: The Keyboard and Mouse Applets will be loaded into the Innovator Module but will not be 
displayed until the Innovator Module is connected to a Breakout Board. 
 
 
4.8 Loading IBoot Applets from the PSI Website 
The following paragraphs describe the formatting and loading of IBoot Applets. The Applets themselves 
are described in their own user guides. This procedure assumes that IBoot Core software has already 
been loaded on the Innovator Module, and IBoot Host and the USB driver have been loaded on the PC. 
 
Before Applets can be loaded on the Innovator Module, they must first be downloaded from the website 
and stored on your PC. It is recommended that you create a subfolder named APPLETS in the folder 
(C:\PSI) that was created when IBoot Host was loaded on the PC. To load Applets from the website, 
proceed as follows: 
 
Step 1: Navigate to the Applets page under Software. 
 
Step 2: Select an Applet File from the list and click on the link. 
 
Step 3: When the File Download screen appears, click on the Save button. 
 
 

 

Figure 138.  Applet File Download Screen 
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Step 4: When the Save As screen (Figure 139) appears, browse to the APPLETS folder created earlier and 
click on the Save button. 

 
Step 5: Repeat these steps for each for each Applet to be loaded on the Innovator Module. 
 
Step 6: When finished, go on to paragraph 4.7, Step 1 to load the Applets on the Innovator. 
 
 

 

Figure 139.  Applet File Save As Screen 
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4.9 Updating IBoot Host 
Before IBoot Host can be updated, the previous version must be removed. In the Windows Control Panel, 
use the Add/Remove Programs option to remove IBoot Host. 
 

 
 
After IBoot Host has been removed, follow the procedures in Chapter 2 of this manual to load the new 
version. 
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Chapter 5 – Running IBoot 
 
5.0 Running IBoot 
After Applets have been loaded IBoot can be used to test certain functional areas of the Innovator and its 
peripherals. Refer to the individual Applet User’s Guides for instructions on what tests the Applets will 
perform. This chapter describes how to navigate around the IBoot screens and the indications shown on 
the IBoot display. 
 
5.1 IBoot Display 
The IBoot user interface consists of a title bar, category button, scroll buttons and Applet Command 
Buttons. 
 
 
 

 

Main Title Bar 

Category Button 

Applet 
Command 

Buttons 

Scroll Buttons

Figure 140.  IBoot Display 
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5.1.1 Main Title Bar 
The title bar contains a battery status indicator that graphically portrays the status of the battery. 
 
The following indications show the status of the Innovator Module’s battery. When the power cord is used, 
the Battery Charging indication will be displayed. 
 

• Innovator Module in running off the Battery –  

• Low Battery –  

• Power Cord is powering the Innovator and charging the Battery –  

 
5.1.2 Category Button 
The category button allows the user to select from a list of categories. Each Applet is organized in a 
particular category. When a category is chosen, only the Applets in that selected category are displayed.  
 
The categories are: 

• Show All – All Applets are displayed 

 

• INFO – Information Applets 

 

• DEMO – Demonstration Applets such as Camera, Color Generator, Display, Doodle and Display 

 

• TEST – Functional test Applets such as Clock, Frontlight, LED, Memory, SDMMC and Codec 

 

• UTIL – Utility Applets such as Memory Utility 

 
5.1.3 Scroll Buttons 
If you have more than one page of Applets, the up/down scroll buttons are used to navigate to the next 
and previous pages. 
 
5.1.4 Applet Command Buttons 
Applet Command Buttons are used to launch the selected Applet. 
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5.2 Memory Configuration Switch Settings 
Before IBoot will display, the Innovator must be turned off and the Memory Configuration switch must be 
set as follows: 
 
 

SW1 – ON 
SW2 – OFF 
SW3 – OFF 
SW4 – OFF 

 
 

1

Figure 141.  M

 
After setting the switches on the Memor
will be displayed as shown in Figure 140
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5.3 Accessing IBoot Applets 
There are several ways to access the IBoot Applets: 

• Touch the Applet Command Button with a stylus or finger to initiate it. 

• Use the Five Pole Switch to navigate up/down/left/right to each applet, and then use the select 
function of the switch to initiate the applet. 

Only one Applet can be running at any one time. The active Applet’s command button will be green. 
Follow the directions within each applet or applet user’s guide to perform that function. 
 
Most applets are designed to exit by either pressing the back button (on the title bar when an Applet is 
active) or by pressing the exit button, which is SW4 on the standard innovator. 
 
NOTE: Switches 4, 5, 6 and 7 are user-defined switches. Only Switch 4 has been programmed to 
be used with IBoot. 
 

 

SW4  

Figure 142.  Innovator Module Switch Locati
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